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Technical Support
If you have difficulties using RecordPad Sound Recorder please read the applicable topic 
before requesting support. If your problem is not covered in this user guide please view the 
up-to-date RecordPad Sound Recorder Online Technical Support at 

www.nch.com.au/recordpad/support.html . 
If that does not solve your problem, you can contact us using the technical support contacts 
listed on that page.

Software Suggestions
If you have any suggestions for improvements to RecordPad Sound Recorder, or suggestions 
for other related software that you might need, please post it on our Suggestions page at 

www.nch.com.au/suggestions/index.html. 
Many of our software projects have been undertaken after suggestions from users like you. 
You get a free upgrade if we follow your suggestion.

www.nch.com.au/recordpad/support.html
www.nch.com.au/suggestions/index.html
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NCH Software Suite
This is a useful way to browse all the software available from NCH Software
You can see a set of products by type like Audio, Video and so on and view the product. From 
there you can try out the product and it will download and install it for you to trial. If you already 
have the product installed then you can click "Run It Now" and the program will be launched for 
you.
There is also a list of features for products in the category. Click on a feature, such as "Edit a 
Video File", to install a product with that ability.
Search  
Search our website for products matching any keywords you type. 
See more of our software  
Browse our website for more software. 
Subscribe to our newsletter 
You can subscribe to our newsletter for announcements of new releases and discounts. You 
can unsubscribe at any time. 
See the latest discounts for purchase  
See the latest discounts we are offering for purchasing our products. 
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About RecordPad Professional Sound Recorder
RecordPad is an advanced sound recording application.
Using the RecordPad Professional Sound Recorder you can:
● Record voice messages or announcements.
● Automatically use a preselected file length, name and volume.
● Export files to a local folder in wav, mp3, aiff and flac format.
● Record files in the background while running other programs.
● Control recording from the command line.
System Requirements 
● Windows XP/Vista/7/8/10
● Pentium 300 or higher CPU
● 32MB or higher RAM
● Sound Card
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Recording Controls
Below are the main function buttons in RecordPad. These buttons are all shown by default, but 
the View menu may be used to hide the buttons you don't want to be shown.
Play (Space bar) 
Plays the last recording. 
Record (F5) 
Click this button to start a new recording, or continue a paused recording.
Pause (F6) 
Click this when you want to pause a recording and continue it later. To continue recording after 
pausing the file, click the record button again.
Retake Recording/Replay (Home) 
Select this option to restart your current recording, or play from the beginning of the file 
currently being played.
Stop/Save (F7) 
Click this to finish and save your current recording in the recordings list.
Options (Ctrl+O) 
Click this to open the Options window. 
Recordings (Ctrl+L)  
Click this button to open the recordings window, and browse through, upload, or modify your 
recordings. For more details, please refer to the Find and Play Recordings section of this help 
manual. 
Delete(Ctrl+D) 
Click this button to delete the last recording made. After clicking this, the last recorded file will 
not appear in the Recordings Window. 
Buy Online  
Click this to purchase a RecordPad software license and registration. For more details, please 
refer to Register Software. 
Help (F1)  
To view the help documentation for RecordPad, click the Help menu and select Help Contents.
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Hash Field Reference
The following fields can be used in File Name Format. Note that in order for all filenames to be 
unique, you must include either %autonumber% or %SS% in your File Name Format. 
● %autonumber% - auto increase number
● %YYYY% - current year
● %MM% - current month
● %DD% - current day of the month
● %HH% - current hour
● %MIN% - current minute
● %SS% - current second
Note:  that the file name format should not contain any other string or characters after 
%autonumber%. 
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Command Line Options
You can easily control RecordPad from command line. The usage of command line is as below:
recordpad [command] [options] 
COMMAND: 
-record [format] [format settings] 
Start recording. The output file will be put in the output folder as set in the current settings. If 
"prompt for file name" is enabled, you will be prompted for a file name before recording begins; 
otherwise, a filename will be automatically generated based on the current settings.
Format Options:  
● wav: record in wav format
● mp3: record in mp3 format
● aif/aiff: record in aiff format
● flac: record in flac format
Format Settings Options: 
If you don't specify each of the format settings, RecordPad will use the current format settings 
to record the file.
Wav file: -s <sfreq> -m <nchans> -b <bitrate>
where:
● -s <sfreq>: sampling frequency of output file(Hz)
● -m <nchans>: number of channels
● -b <bitrate>: set the bitrate in bits
Bitrate Encoding (CBR) mp3 file: -cbr -b <bitrate> [-h] -m <mode> [-p]
where:
● -b <bitrate>: set the bitrate 8/16/24 etc
● -h: higher quality, but a little slower
● -m <mode>: (s)tereo, (j)oint, (f)orce or (m)ono (default j)
● -p: error protection
Bitrate Encoding (VBR) mp3 file: -vbr -b <minbitrate> -B <maxbitrate> -q <n> -m <mode> [-p]
where:
● -b <minbitrate>: specify minimum allowed bitrate
● -B <maxbitrate>: specify maximum allowed bitrate
● -q <n>: quality setting for VBR. default n=4, 0 = high quality, bigger files. 9 = smaller files
● -m <mode>: (s)tereo, (j)oint, (f)orce or (m)ono (default j)
● -p: error protection
Aiff file: -s <sfreq> -m <nchans>
where:
● -s <sfreq>: sampling frequency of output file(Hz)
● -m <nchans>: number of channels
Flac file: -s <sfreq> -m <nchans> -c <compression>
where:
● -s <sfreq>: sampling frequency of output file(Hz)
● -m <nchans>: number of channels
● -c <compression>: compression rate from 0 to 8
-recordfile <filepath> [format settings]
Start recording to a specific file. Please refer to the above section on how to set format 
settings. 
-pause
Pause recording. 
-stop
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Stop recording (if recording) or Stop playback (if playing). 
-play
Playback current recording (must first execute the -stop command). 
-done
Finish recording the current file. 
-restart
Restart recording. 
-resume
Resume recording after it has been paused. 
-outdir <dirpath>
Set the output folder to which RecordPad exports files. 
-exit
Exit RecordPad. 
OPTIONS: 
-show
Show RecordPad when it is running. This is the default setting. 
-hide
Hide RecordPad when it is running. 
-exitifstop
Exit RecordPad if recording is stopped. 
-ms <milliseconds>
Save the current recording file and exit RecordPad automatically after specified number of 
milliseconds. 

7



Keyboard Shortcuts
The following list shows shortcuts for the most common tasks used in RecordPad.
Main Window
● Play Space
● Record F5
● Pause F6
● Retake Recording/Replay Home
● Stop & Mark Done F7
● Delete Last Recording Ctrl+D
● Open Recordings Window Ctrl+L
● Access Program Options Ctrl+O
● Open Help Documentation F1 
● Exit (Turn Off) RecordPad Alt+F4 
Find & Play Recordings
● Play F9 
● Edit Audio Ctrl+E
● Save As Ctrl+S
● Send to Email Now Ctrl+N
● Burn Files to CD-ROM Ctrl+B
● Compress and Back Up Files Ctrl+G
● Convert Sound File Format Ctrl+M
● Transcribe with Express Scribe Ctrl+T
● Reveal in Finder Ctrl+R
● Delete Ctrl+Delete
● Select All Ctrl+A
● Rename F2
● Update Now (Rescan for new recordings) F5
● Close Find & Play Window Esc
Player
● Play/Pause Space
● Go to Start Home
● Go to End End
● Rewind Left
● Forward Right
● Close Esc
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Options
Open the Options Dialog Box by using the menu File -> Options  .
● Record 
● Output 
● Transmit  
● General 
● Hot-Keys 
● Schedule 
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Register Software
A purchased software license and registration is required for using RecordPad after the trial 
period expires.
You should be able to test all the features of RecordPad during the trial period. Thereafter, you 
must purchase a software license (registration). This is easiest to do online at 
www.nch.com.au/recordpad/register 
Once you have purchased and activated your RecordPad license, enter the registration code 
you receive in your email into the Register RecordPad window, found from the File menu. 
Enter your RecordPad Registration Code exactly as it appears. Please note, the code is case 
sensitive - if you enter it incorrectly, the registration code will not be accepted. We recommend 
you copy and paste the code into the registration window.
If your registration code is not accepted...  
1. Check you have entered the registration code exactly as it appears in the email that was 

sent to you.
2. If the license was purchased for an older version of RecordPad, you may need to purchase 

an upgrade license at www.nch.com.au/upgrade . 
For more information, please visit the link http://www.nch.com.au/support/reg.html . 
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Google Authorization Process on Windows XP 
and Vista
Extra steps are required to give RecordPad authorization to upload to Google Drive and/or 
YouTube when running on Windows XP or Windows Vista: 
1. Click Authorize... in the Authorization dialog. 
2. In the web page that opens, sign in to your Google account, if required. 
3. Confirm that you authorize RecordPad to access the requested features. 
4. Copy the Authorization Code  provided by Google and paste it in the Authorization 

confirm dialog in RecordPad. 
5. Click Ready to confirm that authorization is complete. 
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Software License Terms
This EULA limits our liability and is governed by an arbitration agreement and venue 
agreement. Please read below as these terms affect your rights.
1. The copyrights in this software and any visual or audio work distributed with the software 
belong to NCH Software and others listed in the about box. All rights are reserved. Installation 
of this software and any software bundled with or installed-on-demand from this software, 
including shortcuts and start menu folders, is licensed only in accordance with these terms.
2. By installing, using or distributing the software you, on your own behalf and on behalf of your 
employer or principal, agree to be bound by these terms. If you do not agree to any of these 
terms, you may not use, copy, transmit, distribute, nor install this software - return it to the 
place of purchase within 14 days to receive a full refund.
3. This software, and all accompanying files, data and materials, are distributed "as is" and with 
no warranties of any kind, whether express or implied except as required by law. If you intend 
to rely on this software for critical purposes you must test it fully prior to using it, install 
redundant systems and assume any risk.
4. We will not be liable for any loss arising out of the use of this software including, but not 
limited to, any special, incidental or consequential loss. Your entire remedy against us for all 
claims is limited to receiving a full refund for the amount you paid for the software.
5. You may not use this software in any circumstances where there is any risk that failure of 
this software might result in a physical injury or loss of life. You may not use this software if you 
do not regularly backup your computer, or do not have antivirus and firewall software installed 
on the computer, or keep sensitive data unencrypted on your computer. You agree to 
indemnify us from any claims relating to such unauthorized use.
6. You may copy or distribute the installation file of this software in its complete unaltered form 
but you may not, under any circumstances, distribute any software registration code for any of 
our programs without written permission. In the event that you do distribute a software 
registration code, you will be liable to pay the full purchase price for each location where the 
unauthorized use occurs.
7. Use of data collected by the software is subject to the NCH Software Privacy Statement 
which allows automatic anonymized collection of usage statistics in limited circumstances.
8. Choice of Law. If you reside in the United States, your relationship is with NCH Software, 
Inc, a United States company, and this agreement is governed by the laws and courts of 
Colorado. If you reside anywhere in the world outside of the United States, your relationship is 
with NCH Software Pty Ltd, an Australian company, and this agreement is governed by the 
laws and courts of the Australian Capital Territory. Such courts have continuing and exclusive 
jurisdiction over any dispute between you and us, regardless of the nature of the dispute.
9. U.S. Customers Only: Arbitration Agreement and Class Action Waiver: PLEASE READ THIS 
CAREFULLY. IT MAY AFFECT YOUR RIGHTS.
If you reside in the United States, NCH Software and you agree to arbitrate all disputes and 
claims between us. This agreement to arbitrate is intended to be broadly interpreted. 
References to "NCH" "you," and "us" include our respective subsidiaries, affiliates, agents, 
employees, predecessors in interest, successors, and assigns. This arbitration agreement 
does not preclude you from bringing issues to the attention of U.S. federal, state, or local 
agencies. Such agencies can, if the law allows, seek relief against us on your behalf. This 
Agreement evidences a transaction in interstate commerce, and thus the Federal Arbitration 
Act governs the interpretation and enforcement of this provision. This arbitration provision shall 
survive termination of this Agreement.
A party who intends to seek arbitration must first send to the other, by certified mail, a written 
Notice of Dispute ("Notice"). The Notice to NCH should be addressed to:
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Legal Department
NCH Software, Inc.
6120 Greenwood Plaza Blvd, Ste 120
Greenwood Village CO, 80111
USA 
("Notice Address"). The Notice must (a) describe the nature and basis of the claim or dispute; 
and (b) set forth the specific relief sought ("Demand"). If NCH and you do not reach an 
agreement to resolve the claim within 30 days after the Notice is received, you or NCH may 
commence an arbitration proceeding. The amount of any settlement offer made by NCH or you 
shall not be disclosed to the arbitrator.
A. The arbitration will be governed by the Commercial Arbitration Rules and the Supplementary 
Procedures for Consumer Related Disputes (collectively, "AAA Rules") of the American 
Arbitration Association ("AAA"), as modified by this Agreement, and will be administered by the 
AAA. The AAA Rules are available online at adr.org, by calling the AAA at 1-800-778-7879, or 
by writing to the Notice Address. The arbitrator is bound by the terms of this Agreement. All 
issues are for the arbitrator to decide, including issues relating to the scope and enforceability 
of the arbitration provision. Unless NCH and you agree otherwise, any arbitration hearings will 
take place in Greenwood Village Colorado. If your claim is for $10,000 or less, we agree that 
you may choose whether the arbitration will be conducted solely on the basis of documents 
submitted to the arbitrator, through a telephonic hearing, or by an in-person hearing as 
established by the AAA Rules. If your claim exceeds $10,000, the right to a hearing will be 
determined by the AAA Rules. Regardless of the manner in which the arbitration is conducted, 
the arbitrator shall issue a reasoned written decision. NCH will pay all AAA filing, 
administration, and arbitrator fees for any arbitration initiated in accordance with the notice 
requirements above. If, however, the arbitrator finds that either the substance of your claim or 
the relief sought in the Demand is frivolous or brought for an improper purpose then the 
payment of all such fees will be governed by the AAA Rules. In such case, you agree to 
reimburse NCH for all monies previously disbursed by it that are otherwise your obligation to 
pay under the AAA Rules. In addition, if you initiate an arbitration in which you seek more than 
$75,000 in damages, the payment of these fees will be governed by the AAA rules.
B. The arbitrator may award declaratory or injunctive relief only in favor of the individual party 
seeking relief and only to the extent necessary to provide relief warranted by that party's 
individual claim. YOU AND NCH AGREE THAT EACH MAY BRING CLAIMS AGAINST THE 
OTHER ONLY IN YOUR OR ITS INDIVIDUAL CAPACITY, AND NOT AS A PLAINTIFF OR 
CLASS MEMBER IN ANY PURPORTED CLASS OR REPRESENTATIVE PROCEEDING. 
Further, unless both you and NCH agree otherwise, the arbitrator may not consolidate more 
than one person's claims, and may not otherwise preside over any form of a representative or 
class proceeding. If this specific provision is found to be unenforceable, then the entirety of this 
arbitration provision shall be null and void.
C. Notwithstanding any provision in this Agreement to the contrary, we agree that if NCH 
makes any future change to this arbitration provision (other than a change to the Notice 
Address) you may reject any such change by sending us written notice within 30 days of the 
change to the Arbitration Notice Address provided above. By rejecting any future change, you 
are agreeing that you will arbitrate any dispute between us in accordance with the language of 
this provision.
D. To opt out of this Arbitration Agreement and class action waiver send an Opt Out notice to 
the Notice Address stating "I am electing to opt out of the Arbitration Agreement and class 
action waiver contained in the Legal Terms applicable to my purchase of an NCH product." 
Your Opt Out Notice must include the date and proof of purchase. The Opt Out Notice must be 
postmarked no later than thirty (30) days after the date of purchase. A separate Opt Out Notice 
must be sent for each product purchased.
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General - Find and Play Recordings
Find and Play Recordings
Open the Find and Play Recordings dialog box from the Find & Play menu item, or pressing 
the Find & Play Toolbar button. 
All recordings in the specified recording folder will be listed.
Playing a Recording
To play a recording select it and press F9. When the Play Control Box opens you can move 
back and forward within the recording using the left and right arrow keys. To pause playback 
press the spacebar. To stop and go to the beginning press Esc. To move to the beginning 
press Home. To move to the end press End. To go back to the list of recordings press Enter. 

Save As
This will save the selected recording to a different position in a local or networked folder.
To save the recorded file on your hard drive, select the recording and click the "Save" button. 
Enter the file name and click OK. 
Deleting a Recording
To delete recordings, select them and click on the Delete button. You can select more than 
one recording by holding down the Shift key while selecting. 

Send a recording
This option will allow you to send a recording through email. 

Upload a recording
This option will allow you to upload your recordings to different cloud services including Google 
Drive, One Drive, and Dropbox. 

Edit Audio
This will open the selected recording in WavePad: A full featured professional sound editor for 
Windows. When editing audio files you can cut, copy and paste parts of recordings and, if 
required, add effects like echo, amplification and noise reduction. WavePad works as a wav 
editor or mp3 editor but it also supports a number of other file formats including vox, gsm, real 
audio, au, aif, flac, ogg and more. 

WavePad is designed to be a very easy and intuitive to use for audio editing. Within minutes 
you will be able to open or record a file and edit it. But if you take time to explore the other 
features you will find many powerful tools for editing audio designed with the professional 
sound engineer in mind. WavePad comes in two versions a free basic version and a masters 
edition, both with a full-featured trial period. 

Convert Sound File
Converts the audio file(s) to a different format using Switch. Switch audio file converter is very 
easy to use. With the selected files added into Switch, select the format you want to use, and 
then click the convert button. Switch supports converting to wav (PCM, ADPCM+, aLaw+, 
uLaw+, and others), mp3, au, aif/aiff, gsm, vox, raw, ogg, flac, .rss, .amr+ and more. 

Transcribe
Allow simple and easy dictation of files using Express Scribe. This computer transcriber 
application features variable speed wave playback, foot pedal operation, file management and 
more. 

Burn to CD-ROM
The selected files will be imported into Express Burn. Express Burn is also the fastest CD/DVD 
writing program in the world using proprietary optimizing systems. It will also create an index 
file which it will begin burning immediately to a data CD. 

Folder Tab
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By default, Find and Play lists only recordings in the local record folder.
You can change the default folder for holding your audio files or you can change the alternative 
folder to suit your needs. 
If you want to play files over your local area network, install this program on the other computer 
and point it to the folder that the Find and Play Window is referencing. 
View Filter Tab
The View Filter Tab allows searching and filtering on what is displayed in the list view.
You can search or filter what is shown by the text in each column, by the duration of the audio 
or by the date of the recording. 
Speech Search Tab
On the 'Speech Search' tab you can choose to search for keywords in the recordings. You 
must select an installed Speech Recognition engine (eg. Dragon Naturally Speaking, IBM Via 
Voice). Microsoft supplies a free 'Speech Command and Control' engine (filename actcnc.exe) 
and this can be located using an internet search engine. Please note any speech engine used 
must support Context Free Grammars. You can also optionally select a trained speaker for the 
engine. 

If multiple times are found on your speech search clicking on the file will provide a list of the 
"key found at" times. Speech searching places a bookmark to hold the place in the audio when 
multiple times are found so you can jump to the keyword. 
Play Options Tab
Set the sound device you use to play your audio file, also set 'Variable Speed Slow' and 
'Variable Speed Fast' to vary the speed of playback. 
Clicking 'Update Now (Rescan for new recordings)' will add or remove any recordings 
that have been made or deleted since the last update. 

15



Options - Options ~ Record
Recording 
Record Device 
If you have more than one sound card installed, use this list to select the card you want to use 
for recording.
Input Channel  
Use this pull down list to select the input channel for recording. The recommended setting is 
"Microphone" or "Mic-In". If you have problems using the mic-in setting, select Windows 
Record Mixer and open the Windows Record Mixer to manually adjust settings.
Record Volume  
Adjust the recording volume using this fader. When the level is set correctly, the level display 
on the Main Window will just touch into the red when recording.
If you have selected Windows Record Mixer, you can click on the button "Open Windows 
Record Mixer" for manual mixer settings.
Voice Activate Level 
This controls voice activated recording. The default settings is -18dB. If recording starts too 
early, increase the setting to up to -10dB to reduce sensitivity. If recording does not start or 
words are chopped off at the end, reduce the level to -20dB to increase sensitivity. A slider will 
appear on the main window when this feature is enabled. With this control you can adjust the 
level before you begin recording, and visualize when then audio being recorded will trigger 
voice activate. You can also enable and disable this feature by right-clicking on the volume 
meter on the main window. Note: You should adjust the Record Volume Level first. Voice 
Activate problems are often due to incorrect record level settings.
Untick this option if you don't want to use voice activate recording.
Pause RecordPad after Second(s) 
When Voice Activate Level is enabled, you can specify how many seconds to wait before 
RecordPad comes into waiting status.
Create New File when Timeout occurs  
When RecordPad is paused when the above time is reached, if this option is checked, the 
current file will be saved and a new file will be started. 
Maximum Recording Time 
Enable Checking 
Enable this option if you want to place a limit on the length a recording can reach.
You can select the maximum length in the Window to the right.
Time Reached.  
Select "stop recording" to just close and save your recording when the maximum recording 
time has been reached.
Select "create new recording and continue" to generate a new recording when the first 
recording has finished.
Launch recordings window when you stop recording 
Check this box to display the Find and Play Recordings dialog every time you stop recording, 
where all recordings are listed and more options for working with the file are displayed. See the 
Find and Play Recordings topic for more information on the dialog.
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Options - Options ~ Output
Output Format 
Use the Output Format menu to select the file format you want to save a record in (wav, mp3, 
aif, or flac).
You can adjust the compression level or bitrate for the file by clicking the "format settings" 
button. Note that if you are unfamiliar with different wav and mp3 formats you may want to 
leave RecordPad on the default file format settings.
RecordPad always record AIFF files in 44100 Hz sample rate and stereo mode. You can then 
use Switch Audio Converter (which can be downloaded from nch.com.au/switch) to convert to 
the desired format settings you want.
Destination Folder 
This option lets you select the folder to which RecordPad exports files. To use this option, 
either type in the folder where you want to save RecordPad files, or use the browse button on 
the right to locate the folder.
Output File Name  
Select the "Prompt for file name before starting recording" option if you want to select a 
different name for each file recorded. 
Click "View Sample" to view a sample file name using current settings. 
Select the "use this file name format" when you want to define the file name before you start 
recording. See the Hash Field Reference section for more information on automatic file 
names. 
Click "Reset Auto Number to 0" to reset auto number to 0. 
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Options - Options ~ Transmit
Send recordings by email 
If this option is selected, RecordPad will send all recordings to the specified email address as 
an attachment to an email. This can be useful if you want to listen to recordings remotely.
By default RecordPad uses MAPI to send emails using your MAPI email software (e.g., 
Outlook, Eudora, etc.). Check that your version of email software supports MAPI and set it to 
be the default MAPI client.
If you have problems using MAPI, RecordPad can also send emails directly using your ISP's 
SMTP server. Open "Email Send Settings" and select the "Use SMTP to send email directly to 
server" option and enter the name of your ISP's SMTP server (e.g., smtp.yourisp.com).
For more information, please refer to Problems sending Emails using MAPI and SMTP. 
Upload recordings via internet using FTP  
If you have a FTP server or a website (with FTP access), select this option to make RecordPad 
upload all recordings to your server. This can be useful for backup purposes or to make the 
recordings available on the internet (either public or private depending on your FTP server 
setup).
You must enter the ftp server (e.g., ftp.yourdomain.com), your username, password and the 
exact full folder into which you want the files uploaded (e.g., /home/yoursite/www/recordings).
If you have any problems with the FTP setup, we strongly recommend you attempt to login 
manually with FTP software (e.g., WS_FTP, CuteFTP) to double check you have the correct 
full path to the upload folder.
For more information, please refer to Problems when connecting to an FTP server. 
Mirror all recordings to this folder 
If you have a backup drive or want to backup all recordings over the network, you can use this 
option. Note that recordings are only transferred after recording and compression is complete.
Run external .exe  
This is an advanced option to allow IT professionals add other transmit features to RecordPad. 
For example to use a proprietary codec or to insert the file in a database.
If this option is ticked, after RecordPad has completed recording the file, it will run the specified 
.exe program. The program is usually a command-line program. The name of the file can be 
sent as an argument using %s which RecordPad replaces with the full path to the file. 
Remember to include the full path to your .exe (enclose it in "") and to enclose the %s in 
inverted commas too. An example might be "C:\Program Files\MyProgram\myexe" -myoptions 
"%s".
Prompting  
In the Prompting section, you can select whether recordings are automatically sent upon 
completion, or if you would like RecordPad to verify that you would like to send the recording 
first.
Other 
Do not send when length is equal to or less than (seconds)
To prevent sending short recordings that are unusable, enter a cutoff length in seconds into the 
edit box.
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Options - Options ~ General
Tone  
With these options you can choose to have a tone play when RecordPad starts or stops.
Click the top box to play a tone when the recording starts, and the middle box to play a tone 
when it stops.
In some environments you are required to play a tone while recording. To do this, tick the box 
"Sound record tone every (secs)" and enter the number of seconds between tones in the edit 
box.
Startup 
Run RecordPad when computer starts  
Click this box to have RecordPad automatically open when the computer starts up.
Start recording automatically when RecordPad runs  
Click this box to have RecordPad automatically start recording whenever it runs.
Low Disc Space Warning 
Warn when hard drive space is low (below MB) 
RecordPad will warn you when your hard drive space is running low. Enter a number into the 
edit field, in megabytes, when you would like to be notified of low disk space.

19



Options - Options ~ Hot-Keys
To open System-Wide Hot-Keys Settings use the menu Options -> Hot-Key.
When you are working with RecordPad open in the foreground, you can control recording 
using the Standard Recording Buttons. 
You can also assign hot-keys that can be used to control recording while you are working in 
other application with RecordPad in the background. To do this, use the Hot-Keys tab of 
Options. Click Add, press the key that you want to use (including Alt or Ctrl if required) then 
select the command.
To change an existing hot key, select the hot key and click "Change...". 
To delete an existing hot key, select the hot key and click "Delete...". 
Note: Hot key assignments override the standard key assignments.
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Options - Options ~ Schedule
To schedule recordings ahead of the time you can use RecordPad's schedule feature.
You can see the list of scheduled recordings by choosing the Schedule  tab under Options.
To add a scheduled recording, just click on the Add...  button. You can then select one of the 
available schedule types including One time , Daily , or Weekly . For a one time schedule you 
will need to also select the start and the end dates. You will need to select the start and end 
time of the scheduled recording. Daily recordings will take place every day of the week at the 
specified time, and weekly recordings will be scheduled on the days selected at the bottom of 
the window.
You can also use the Active checkbox on the top of the dialog to activate and deactivate the 
scheduled recordings whenever you do or do not need them.
Scheduled recordings can also be modified by selecting them from the list and clicking on the E
dit...  button.
In order to record when the user is logged off, you can use the Record even if the user is not 
logged in  option. After checking the box, RecordPad will prompt you with a dialog to enter 
your account details. The details will be used to run RecordPad. Please note that enabling this 
option will result in your recording taking place in the background . Therefore, once this 
option is enabled you will not be able to interact with RecordPad.
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Screen References - Backup Audio
The "Backup Audio" dialog can be used make a backup copy of an audio recording to a 
recordable CD or a selected drive or folder. 
Note: Other data associated with the audio will not be backed-up with the audio. 
Compress and Copy Selected Files to  
Select where to backup the audio: 

● CD (using Express Burn)  
The compressed audio will be recorded to a CD, as data files, using Express Burn. If 
Express Burn is not already installed on your machine, it will be automatically 
downloaded and installed for you. 

● A shared network or local folder  
The compressed audio file will be copied to the selected drive or folder. 

Audio Compression  
Select the file format and codec for compressing the audio. 
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Screen References - Custom Resolution
This dialog allows you to set up the resolution for your video during saving. To set a custom 
resolution, click the Save button on the toolbar and select the Disc: Make Data Disc, 
Computer/Data, Portable Device, Image Sequence, or Stereoscopic 3D options. From the 
Resolution drop menu, select Custom.
In the Custom Resolution dialog that opens, input the width and height in pixels and click OK.
If Keep aspect ratio checkbox is available, you can check it to retain the same aspect ratio 
when changing the width or height. 
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Screen References - Custom Frame Rate
This dialog allows you to set up the frame rate (number of frames per second) for your video. 
To set a custom frame rate, click the Save button on the toolbar and select either of the Disc: 
Make Data Disc, Computer/Data, Portable Device, or Stereoscopic 3D options. From the 
Frame Rate drop menu, select Custom.
In the Custom Frame Rate dialog that opens, input the frame rate and click OK.
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Screen References - Detected Format
This dialog shows you the detected format of the video sequence during the saving process. 
To detect the format of your video, click the Export Video button on the Home tab bar and 
select either of the following options: Video File, 3D Video File, Portable Video, Lossless 
Video, Blu-ray Movie Disc, Blu-ray Data Disc, DVD Movie Disc, DVD Data Disc, Image 
Sequence, YouTube, Flickr, Dropbox, Google Drive, OneDrive, or Vimeo.
Click the Detect button next to the Preset field. Detect will adjust the video output resolution 
format based on your monitor screen size.
If you want to use a different format you can select the format from the Preset drop-down list.
Click OK to use the selected format as the output format.

25


